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e to copy, distribute, display, and perform the work
e to make derivative works

Under the following conditions:

@

Attribution. You must attribute the work in the manner specified
by the author or licensor.

Noncommercial. You may not use this work for commercial
purposes.

Share Alike. If you alter, transform, or build upon this work, you
may distribute the resulting work only under a license identical to
this one.

e For any reuse or distribution, you must make clear to others the license terms of

this work.

¢ Any of these conditions can be waived if you get permission from the copyright

holder.

Your fair use and other rights are in no way affected by the above.

This is a human-readable summary of the Legal Code (the full license) at the end
of this document.

Disclaimer [



http://creativecommons.org/licenses/disclaimer-popup?lang=en
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About @ONE

As California’s community colleges take on the challenge of effectively integrating
technology into instruction and services, they do so with the goals of increased student
access and improved student outcomes. The @ONE project has been funded by the
California Community Colleges Chancellor’s Office to build a statewide training
infrastructure with an electronic learning community as an integral support and
connection for faculty throughout the state. The @ONE project is a faculty driven
community college consortium that is dedicated to providing resources to community
college faculty and staff to support learning and students in the 21st century.

@ONE Mission

The mission of @ONE is to assist California Community College faculty and staff to
enhance student learning and success through expanded uses of effective technology
by providing training, online resources and support.

About this Guide

This booklet contains information about merging documents in Office 2003 and assumes
familiarity with the Windows operating system and Microsoft Word 2003. In order to
successfully use Mail Merge, you need to have familiarity with creating tables in
Word OR with creating spreadsheets in Excel. You can find out more information on
each of these tools/applications at the @ONE website: http://one.evc.edu from the
“Tables in Microsoft Word 2003 booklet and the “Introduction to Microsoft Excel 2003”
booklet.

We would like to thank De Anza College for providing us with the original documentation
from their “Merging Documents in Office 97/98” that provided the framework for this
material.

Permission to Use & Reprint @ONE Training Materials

Modification, reprinting and distribution of these training materials throughout the
California Community College system is authorized and encouraged, provided that
@ONE is acknowledged as the original author (e.g. add this line before reprinting:
"These training materials adapted with permission from @ONE, http://one.evc.edu,
[date]).

If you are outside the California Community College system and wish to use/adapt any
@ONE training materials, please contact the @ONE Office at 408.274.7900 ext. 6534,
or write to one@evc.edu, to make arrangements.

Copyright © 2005, @ONE, California Community Colleges
Evergreen Valley College « 3095 Yerba Buena Road ¢ San Jose, CA « 95135
408.274.7900 ext. 6534 « http://one.evc.edu « one@evc.edu
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About Merging

Mail merge is used when you want to create form letters, mailing labels or envelopes in
a Word document using data from a database of names and addresses. When you use
the Mail Merge feature you are taking information from one source/document in Office
2003 and placing it into a Word document (e.g. a form letter, mailing labels or

envelope).

Before beginning work with merging, there are some key terms you need to understand:

- Main Document

- Data Source

- Mail Merge Helper

- Mail Merge Toolbar

- Merge Field

The document containing the actual form letter that you want
data to be applied to.

The Word document/table or Excel spreadsheet where the data
to be applied to your main document are located.

The helper window that appears to assist you with the mail
merge process.

This appears once you have specified your Main Document
and Data Source and have merged the documents. It allows
you to modify your Main Document/Form Letter.

The data located in your Data Source that you want to appear

in your Main Document/Form Letter. For instance, if you had a
Data Source pulled from a Word table and that table contained
headings such as First Name and Last Name, the merge fields
you could place in your Main Document would be First_Name

and Last_Name.
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Form Letters

You can merge names, addresses and other information from existing Word tables or
Excel spreadsheets into a form letter, where a different letter is automatically created for

every person in the existing Word table or Excel spreadsheet.

Creating the Main Document/Form Letter

1.
2.

3.

Start a new, blank document in Word.

Type in the content of your form letter. To make placement of data from your
data source easier, you may want to press enter once to give yourself an extra

line above your letter text.

Here is some text you can use as an example:

Dear

Thank you for your generous donation to the department. Your
contribution makes it possible for us to obtain new equipment
and offer our students the best facilities possible in which to
learn.

Your contribution will be listed in our upcoming issue of Student
Voice, our campus’ newspaper. Expect your courtesy copy of
this newspaper the week of October 1.

Thank you again.

Sincerely,

Department Head

Once you have created your form letter, save your document. For this practice,

save your file on your desktop and call it My Letter.

Create Your Data Source

If you don’t have an existing data source (either a Word table or an Excel spreadsheet)
to use with your form letter, you will need to create one. Each table or spreadsheet
column should have a heading. You should also try to avoid blank lines/rows in your
table/spreadsheet or this will create blank form letters, envelopes, or mailing labels.

1.

2.

Start a new blank document in Word and create a table with the correct number
of rows and columns for your data OR start a new workbook in Excel.
Enter your data. Here is a sample data source you can create for practice, either

in Excel or in a table in Word:
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First Last Title Amount Department Dept. Head

Dan Johnson | Mr. $150 Biology Julie Smith

Karen Brown Mrs. $2000 Computer Edith Bradford
Science

Leslie Waters Ms. $450 Mathematics Steve Hampton

3.

Save your document/spreadsheet. For this example, save your file on your

desktop and call it My Addresses.

Note: For more information on tables in Word, see the “Tables in Microsoft Word 2003”
booklet. For more information on Spreadsheets in Excel, see the “Introduction to
Microsoft Excel 2003” booklet. These booklets can be found at http://one.evc.edu/

Mail Merge

Choose your Main Document and Data Source

1. Open the Form Letter you created on page 2 (“My '”""_"'"?; T
Letter”) )

2. Go to the Tools pull-down menu and select Letters and ~ *toememies
Mailings—>Mail Merge. The Mail Merge task pane will wrking it
open on the right hand side. = ;i‘:;mm:

3. Click on the Letters button, and then Next at the bottom N Bk
of the task pane to move to Step 2. ) Labels

4. The next pane appears, asking you if you want to set Ll
up your letter. Under Select starting document, choose 'g‘;}’;mmammwm
“Use the current document” since you've already S ek b Lt
created your letter. Click Next at the bottom of the task e e
pane to go to Step 3.

5. Under Select recipients, click on “Use an existing list”,
and then “Browse” under “Use an existing list.

6. Locate your data source in the window that appears
and double-click on it. If you created a data source
using the instructions on the previous page, you should
select the "My Addresses” file on your desktop. Click
Next when you have selected your data source, to go
to Step 4.

7. Since you have already prepared your form letter, you ~ *®'®®
can modify your recipient information, which is e
discussed in the next section.
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Place Fields in your Form Letter

You can set up certain fields in your form letter by using items listed in the task pane or
Mail Merge toolbar. If you do not see the Mail Merge Toolbar, go to
View->Toolbars->Mail Merge.

Mail Merge > x
Ao B 33 meertWordField= | 52 B 3 @ [ H 4 1 bW Ty

1. Place your insertion point where you want your first
Merge Field to appear, creating spaces and punctuation

Ingart:
as necessary. I Ardrass Felds £+ Database Felds

2. Click on the Insert Merge Fields button in the toolbar, or “More B
items” hyperlink in the task pane. An Insert Merge field dialog _jla_sx -

box appears. s
3. Select the field you want to insert. Diept_Head

For instance, if you want to place a person’s title and last

name in your form letter after “Dear,” you would

o click after “Dear” and insert a space,

e insert the “Title” field and insert a space, and 2l

e insert the “Last” field, and insert a comma. e I |
4. Continue placing fields into your document where necessary. If

you are using the sample letter from page two, you document should look

similar to the one on the next page when you're finished inserting fields.

Dear ¢« Titler «Lasts

Thank you for your generous donation to the department. Your contribution makes it
possible for us to obtain new equipment and offer our students the best facilities possible
m which to learn,

Your contribution will be hsted in our upcoming tssue of Student Voice, our campus’
newspaper. Expect yvour courtesy copy of this newspaper the weel of October 1.

Thank you again,
Sincerely,

aDept Headn
Department Head

Preview Your Form Letter
1. Click the View Merged Data button in your Mail Merge s
Toolbar, or Next to go to Step 5 in your task pane, to see a o
sample of your form letter as it will look with information merged into it from your
data source (instead of the data fields). Click this button again to view the fields
in your form letter.

2. With the View Merged Data button selected, use the navigational buttons to look
through your form letters.
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FirstRecord |—» 4 4 1 = lle—| Last Record

p. 4 A
f 0\
Next Record
Previous Goto
Record Record

In View Merged Data mode, record 1 of the above letter would look like the
sample below:

Dear Mr. Johnson

Thank you for your genercus donation to the department. Your contribution makes it
possible for us to obtain new equipment and offer our students the best facilities possible
in which to learn.

Your contribution will be listed in our upcoming 1ssue of Student Voice, our campus’
newspaper. Expect your courtesy copy of this newspaper the week of October 1

Thank you again.
Sincerely,

Julie Smaith
Department Head

Checking your Mail Merge Data

If you are working with a particularly large data source to create form

letters, envelopes, or labels, you may want to use the Check For Errors =y
button in your Mail Merge Toolbar. Do this before your merge your data.

Merging Data
Once you've previewed your form letter, it's time to

merge the data. eSS
1. Click the Merge to New Document button in =] '
your Mail Merge Toolbar, or click Next in your
task pane to go to Step 6, and click on the Edit
individual letters hyperlink. The Merge to New
Document window will appeatr.

Pri

L 9 Editindividual letters, ).

Merge to New Docuiit X

Merge recards

i~ Current record

- Fron: I To: I
(4 I Cancel |
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2. You can also select other merge options: Merge

Merge to Printer [
When you choose this option, the Merge to Printer i Edit individual letters. ..
dialogue box will open, allowing you to select options for

printing your form letters.

Merge to a New Document

A new file will be created with all your form letters contained in it, each on a
different page. This option is best if you want to make individual additions to each
form letter. For example, if you want to type a special note on a few of the form
letters, you'll want to choose this option.

Merge to Electronic Malil

This option only works with the Microsoft Outlook application and in order to use
this option, you need an email field in your data source. When you click on the
Merge to Email button, a dialogue box will open. You will need to choose the field
from your data source that contains the email addresses and type in your subject
line. When you click OK, Microsoft Outlook will automatically launch and the
emails will be sent to your outbox. When you send mail, those messages will be
sent.

3. Specify the records you want to merge. If you don’t want to create form letters for
all the records in your database, you can specify that using the From and To
boxes in the dialogue box.

4. Click OK.

Creating Envelopes and Labels Using Mail

Mail Merge b
Merge e
Creating envelopes and labels is similar to creating form
letters. Arrange your envelope

If vou have not already done =a,

lay out vaur envelope now,
To Create Envelopes L 5

1. Start a new blank document in Word. G el
2. Open the Mail Merge Helper (Tools->Letters and fhe dﬂcumeﬁtj’ R e

Mailings—>Mail Merge). The Mail Merge task pane appears on
the right hand side.

3. Click on the Envelopes button, and then Next to go to
Step 2. Click on the “Envelope options” hyperlink to
specify your envelope and printing options. Click Next
to go to Step 3 when you are finished.

4. Chose your data source (page 3) and then click Next to
go to Step 4.

5. To arrange your envelope, insert your Merge Fields

=] Address black...,

= Greetingling. ..

_f| Electronic postage. ..

Il Postal bar code...

When vimntha i=hed arranging
vour envelope, click Mext, Then
wou can preview each recipient's
envelape and make any individual
changes,
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into the space provided in the Envelope Address window, inserting spaces and
punctuation as necessary.
6. Click Next to go to Step 5 and preview your envelope. You will see your envelope
with the data fields visible.
Type in your return address, if necessary.
Click Next to go to Step 6 and merge your envelopes (page 6).

© ~N
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To Create Labels

Start a new blank document in Word.

Open the Mail Merge task pane (Tools—>Letters and Mailings->Mail Merge).

Click on Labels, and then Next to go to Step 2. Click on the “Label options”

hyperlink to specify your label and printing options. Click Next to go to Step 3.

4. Choose your data source (page 3) and then Next to go to Step 4.

5. To arrange your labels, insert your Merge Fields in the space provided in the
Label Address window, inserting spaces and punctuation as necessary.

6. Click Next to go to Step 5 and preview your labels. You will see your labels with
the data fields visible.

7. Click Next to go to Step 6 and merge your labels (page 6).

wn P
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@creat ive
/commons

Attribution-NonCommercial-ShareAlike 2.5

CREATIVE COMMONS CORPORATION IS NOT A LAW FIRM AND DOES NOT
PROVIDE LEGAL SERVICES. DISTRIBUTION OF THIS LICENSE DOES NOT
CREATE AN ATTORNEY-CLIENT RELATIONSHIP. CREATIVE COMMONS
PROVIDES THIS INFORMATION ON AN "AS-IS" BASIS. CREATIVE COMMONS
MAKES NO WARRANTIES REGARDING THE INFORMATION PROVIDED, AND
DISCLAIMS LIABILITY FOR DAMAGES RESULTING FROM ITS USE.

License

THE WORK (AS DEFINED BELOW) IS PROVIDED UNDER THE TERMS OF THIS
CREATIVE COMMONS PUBLIC LICENSE ("CCPL" OR "LICENSE"). THE WORK IS
PROTECTED BY COPYRIGHT AND/OR OTHER APPLICABLE LAW. ANY USE OF
THE WORK OTHER THAN AS AUTHORIZED UNDER THIS LICENSE OR
COPYRIGHT LAW IS PROHIBITED.

BY EXERCISING ANY RIGHTS TO THE WORK PROVIDED HERE, YOU ACCEPT
AND AGREE TO BE BOUND BY THE TERMS OF THIS LICENSE. THE LICENSOR
GRANTS YOU THE RIGHTS CONTAINED HERE IN CONSIDERATION OF YOUR
ACCEPTANCE OF SUCH TERMS AND CONDITIONS.

1. Definitions

a. "Collective Work" means a work, such as a periodical issue, anthology or
encyclopedia, in which the Work in its entirety in unmodified form, along with a
number of other contributions, constituting separate and independent works in
themselves, are assembled into a collective whole. A work that constitutes a
Collective Work will not be considered a Derivative Work (as defined below) for
the purposes of this License.

b. "Derivative Work" means a work based upon the Work or upon the Work and
other pre-existing works, such as a translation, musical arrangement,
dramatization, fictionalization, motion picture version, sound recording, art
reproduction, abridgment, condensation, or any other form in which the Work
may be recast, transformed, or adapted, except that a work that constitutes a
Collective Work will not be considered a Derivative Work for the purpose of this
License. For the avoidance of doubt, where the Work is a musical composition or
sound recording, the synchronization of the Work in timed-relation with a moving
image ("synching") will be considered a Derivative Work for the purpose of this
License.

c. "Licensor" means the individual or entity that offers the Work under the terms of
this License.

© 2005 @ONE http://one.evc.edu 9



d. "Original Author" means the individual or entity who created the Work.

e. "Work" means the copyrightable work of authorship offered under the terms of
this License.

f.  "You" means an individual or entity exercising rights under this License who has
not previously violated the terms of this License with respect to the Work, or who
has received express permission from the Licensor to exercise rights under this
License despite a previous violation.

g. "License Elements" means the following high-level license attributes as
selected by Licensor and indicated in the title of this License: Attribution,
Noncommercial, ShareAlike.

2. Fair Use Rights. Nothing in this license is intended to reduce, limit, or restrict any
rights arising from fair use, first sale or other limitations on the exclusive rights of the
copyright owner under copyright law or other applicable laws.

3. License Grant. Subject to the terms and conditions of this License, Licensor hereby
grants You a worldwide, royalty-free, non-exclusive, perpetual (for the duration of the
applicable copyright) license to exercise the rights in the Work as stated below:

a. to reproduce the Work, to incorporate the Work into one or more Collective
Works, and to reproduce the Work as incorporated in the Collective Works;

b. to create and reproduce Derivative Works;

c. to distribute copies or phonorecords of, display publicly, perform publicly, and
perform publicly by means of a digital audio transmission the Work including as
incorporated in Collective Works;

d. to distribute copies or phonorecords of, display publicly, perform publicly, and
perform publicly by means of a digital audio transmission Derivative Works;

The above rights may be exercised in all media and formats whether now known or
hereafter devised. The above rights include the right to make such modifications as are
technically necessary to exercise the rights in other media and formats. All rights not
expressly granted by Licensor are hereby reserved, including but not limited to the rights
set forth in Sections 4(e) and 4(f).

4. Restrictions. The license granted in Section 3 above is expressly made subject to
and limited by the following restrictions:

a. You may distribute, publicly display, publicly perform, or publicly digitally perform
the Work only under the terms of this License, and You must include a copy of,
or the Uniform Resource Identifier for, this License with every copy or
phonorecord of the Work You distribute, publicly display, publicly perform, or
publicly digitally perform. You may not offer or impose any terms on the Work
that alter or restrict the terms of this License or the recipients' exercise of the
rights granted hereunder. You may not sublicense the Work. You must keep
intact all notices that refer to this License and to the disclaimer of warranties. You
may not distribute, publicly display, publicly perform, or publicly digitally perform
the Work with any technological measures that control access or use of the Work
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in @ manner inconsistent with the terms of this License Agreement. The above
applies to the Work as incorporated in a Collective Work, but this does not
require the Collective Work apart from the Work itself to be made subject to the
terms of this License. If You create a Collective Work, upon notice from any
Licensor You must, to the extent practicable, remove from the Collective Work
any credit as required by clause 4(d), as requested. If You create a Derivative
Work, upon notice from any Licensor You must, to the extent practicable, remove
from the Derivative Work any credit as required by clause 4(d), as requested.

b. You may distribute, publicly display, publicly perform, or publicly digitally perform
a Derivative Work only under the terms of this License, a later version of this
License with the same License Elements as this License, or a Creative
Commons iCommons license that contains the same License Elements as this
License (e.g. Attribution-NonCommercial-ShareAlike 2.5 Japan). You must
include a copy of, or the Uniform Resource Identifier for, this License or other
license specified in the previous sentence with every copy or phonorecord of
each Derivative Work You distribute, publicly display, publicly perform, or publicly
digitally perform. You may not offer or impose any terms on the Derivative Works
that alter or restrict the terms of this License or the recipients' exercise of the
rights granted hereunder, and You must keep intact all notices that refer to this
License and to the disclaimer of warranties. You may not distribute, publicly
display, publicly perform, or publicly digitally perform the Derivative Work with
any technological measures that control access or use of the Work in a manner
inconsistent with the terms of this License Agreement. The above applies to the
Derivative Work as incorporated in a Collective Work, but this does not require
the Collective Work apart from the Derivative Work itself to be made subject to
the terms of this License.

c. You may not exercise any of the rights granted to You in Section 3 above in any
manner that is primarily intended for or directed toward commercial advantage or
private monetary compensation. The exchange of the Work for other copyrighted
works by means of digital file-sharing or otherwise shall not be considered to be
intended for or directed toward commercial advantage or private monetary
compensation, provided there is no payment of any monetary compensation in
connection with the exchange of copyrighted works.

d. If you distribute, publicly display, publicly perform, or publicly digitally perform the
Work or any Derivative Works or Collective Works, You must keep intact all
copyright notices for the Work and provide, reasonable to the medium or means
You are utilizing: (i) the name of the Original Author (or pseudonym, if applicable)
if supplied, and/or (ii) if the Original Author and/or Licensor designate another
party or parties (e.g. a sponsor institute, publishing entity, journal) for attribution
in Licensor's copyright notice, terms of service or by other reasonable means, the
name of such party or parties; the title of the Work if supplied; to the extent
reasonably practicable, the Uniform Resource Identifier, if any, that Licensor
specifies to be associated with the Work, unless such URI does not refer to the
copyright notice or licensing information for the Work; and in the case of a
Derivative Work, a credit identifying the use of the Work in the Derivative Work
(e.g., "French translation of the Work by Original Author,” or "Screenplay based
on original Work by Original Author"). Such credit may be implemented in any
reasonable manner; provided, however, that in the case of a Derivative Work or
Collective Work, at a minimum such credit will appear where any other
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comparable authorship credit appears and in a manner at least as prominent as
such other comparable authorship credit.

e. Forthe avoidance of doubt, where the Work is a musical composition:

i. Performance Royalties Under Blanket Licenses. Licensor reserves the
exclusive right to collect, whether individually or via a performance rights
society (e.g. ASCAP, BMI, SESAC), royalties for the public performance
or public digital performance (e.g. webcast) of the Work if that
performance is primarily intended for or directed toward commercial
advantage or private monetary compensation.

ii. Mechanical Rights and Statutory Royalties. Licensor reserves the
exclusive right to collect, whether individually or via a music rights agency
or designated agent (e.g. Harry Fox Agency), royalties for any
phonorecord You create from the Work ("cover version") and distribute,
subject to the compulsory license created by 17 USC Section 115 of the
US Copyright Act (or the equivalent in other jurisdictions), if Your
distribution of such cover version is primarily intended for or directed
toward commercial advantage or private monetary compensation.

f. Webcasting Rights and Statutory Royalties. For the avoidance of doubt,
where the Work is a sound recording, Licensor reserves the exclusive right to
collect, whether individually or via a performance-rights society (e.qg.
SoundExchange), royalties for the public digital performance (e.g. webcast) of
the Work, subject to the compulsory license created by 17 USC Section 114 of
the US Copyright Act (or the equivalent in other jurisdictions), if Your public
digital performance is primarily intended for or directed toward commercial
advantage or private monetary compensation.

5. Representations, Warranties and Disclaimer

UNLESS OTHERWISE MUTUALLY AGREED TO BY THE PARTIES IN WRITING,
LICENSOR OFFERS THE WORK AS-IS AND MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND CONCERNING THE WORK, EXPRESS, IMPLIED,
STATUTORY OR OTHERWISE, INCLUDING, WITHOUT LIMITATION, WARRANTIES
OF TITLE, MERCHANTIBILITY, FITNESS FOR A PARTICULAR PURPOSE,
NONINFRINGEMENT, OR THE ABSENCE OF LATENT OR OTHER DEFECTS,
ACCURACY, OR THE PRESENCE OF ABSENCE OF ERRORS, WHETHER OR NOT
DISCOVERABLE. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF
IMPLIED WARRANTIES, SO SUCH EXCLUSION MAY NOT APPLY TO YOU.

6. Limitation on Liability. EXCEPT TO THE EXTENT REQUIRED BY APPLICABLE
LAW, IN NO EVENT WILL LICENSOR BE LIABLE TO YOU ON ANY LEGAL THEORY
FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR EXEMPLARY
DAMAGES ARISING OUT OF THIS LICENSE OR THE USE OF THE WORK, EVEN IF
LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

7. Termination

a. This License and the rights granted hereunder will terminate automatically upon
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any breach by You of the terms of this License. Individuals or entities who have
received Derivative Works or Collective Works from You under this License,
however, will not have their licenses terminated provided such individuals or
entities remain in full compliance with those licenses. Sections 1, 2, 5, 6, 7, and 8
will survive any termination of this License.

b. Subject to the above terms and conditions, the license granted here is perpetual
(for the duration of the applicable copyright in the Work). Notwithstanding the
above, Licensor reserves the right to release the Work under different license
terms or to stop distributing the Work at any time; provided, however that any
such election will not serve to withdraw this License (or any other license that has
been, or is required to be, granted under the terms of this License), and this
License will continue in full force and effect unless terminated as stated above.

8. Miscellaneous

a. Each time You distribute or publicly digitally perform the Work or a Collective
Work, the Licensor offers to the recipient a license to the Work on the same
terms and conditions as the license granted to You under this License.

b. Each time You distribute or publicly digitally perform a Derivative Work, Licensor
offers to the recipient a license to the original Work on the same terms and
conditions as the license granted to You under this License.

c. If any provision of this License is invalid or unenforceable under applicable law, it
shall not affect the validity or enforceability of the remainder of the terms of this
License, and without further action by the parties to this agreement, such
provision shall be reformed to the minimum extent necessary to make such
provision valid and enforceable.

d. No term or provision of this License shall be deemed waived and no breach
consented to unless such waiver or consent shall be in writing and signed by the
party to be charged with such waiver or consent.

e. This License constitutes the entire agreement between the parties with respect to
the Work licensed here. There are no understandings, agreements or
representations with respect to the Work not specified here. Licensor shall not be
bound by any additional provisions that may appear in any communication from
You. This License may not be modified without the mutual written agreement of
the Licensor and You.

Creative Commons is not a party to this License, and makes no warranty whatsoever in
connection with the Work. Creative Commons will not be liable to You or any party on
any legal theory for any damages whatsoever, including without limitation any general,
special, incidental or consequential damages arising in connection to this license.
Notwithstanding the foregoing two (2) sentences, if Creative Commons has expressly
identified itself as the Licensor hereunder, it shall have all rights and obligations of
Licensor.

Except for the limited purpose of indicating to the public that the Work is licensed under
the CCPL, neither party will use the trademark "Creative Commons" or any related
trademark or logo of Creative Commons without the prior written consent of Creative
Commons. Any permitted use will be in compliance with Creative Commons' then-
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current trademark usage guidelines, as may be published on its website or otherwise
made available upon request from time to time.

Creative Commons may be contacted at http://creativecommons.org/.
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